
  

 
 
 
 
 
 

Phase I Instructions 
for: 

    
 GETTING 

APPLICATIONS TO 
HIRING 

MANAGERS/ 
SUPERVISORS 
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• Open your Internet Explorer browser 
• In the address bar, type 69.225.112.10 and hit enter 
• Click on Login in the upper right corner 
 

 
 
• Type in your user name and password for the Online Hiring Center (OHC) 
• Select the “Online Hiring Center – Departments” radio button 
• Click Login – your welcome screen will appear and show all of your open requisitions 
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• Click on “My List” 
 

 
 
• Find the Req. # for the applications you would like to view.  In this example, Jane Instructor 

needs to see applications for the Admin Mgr position.  (The “My List” feature in the OHC is 
the list of Eligible applicants the HR Manager has referred to the hiring manager/ supervisor)   

 

 
 
• From the Referred Lists screen, click on the Print link under the “Applications” column. 
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A screen similar to this is what you will see after you click on Print under the “Applications” 
column. 
 

 
 
• Next, click on “Download All Applications”   - OR - 
 

 
 
• If you only want to download select application(s), select the names of the applicants in the 

column on the left hand side of the page that you want to download.  (In this example, Jane 
only wants Elvis Pressley’s applications.) 

• Click on “Download Selected Applications” 
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A new window should appear that looks similar to this one: 
 

 
 
If the screen above appeared, skip page 5 and continue on to page 6 
 
If your screen displays a message that looks like this, you will need to set your pop-up blocker to 
allow you to view pages from this site.  
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INSTRUCTIONS FOR SETTING YOUR POP-UP BLOCKER 
 
 

 
 

1. Right click on pop-up blocker message in tool bar and a drop down menu will be 
displayed 

2. Click “Always allow Pop-ups from This Site”  
3. A new message window may display that says “Allow pop-ups from this site?”   

 
 

 
 

 
4. If this window is displayed, Click “Yes” 

 
 

5. Click on “Return to My List” and follow the same steps to download the application(s) 
until a new separate window appears 



 6      

After you have downloaded the applications, you will see a screen similar to this: 
 

 
 
In order to save this document to send as an attachment in an email to your hiring managers, you 
will need to do the following: 
 
• Click on File from the menu bar at the top left corner of the page 
 

 
 
• If you have it as an option, click on Edit with Microsoft Word  (If you don’t see this option, 

skip to page 8) 
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This will open up the application in MS Word if you have that option.   
 

 
 
• After the applications are opened in MS Word, click on File in the upper left-hand corner 
• Select Save As… 
 

 
 

• Type a file name next to the “File Name” field.  You may want to include the Req #, the Job 
Title, and/or the Hiring Manager’s in the file name. 

• In the “Save as Type” field, select Word Document from the drop down menu 
• Click on the Save button 
• Next, open your email and create a new message to the hiring manager/supervisor.  Attach 

the file you just created to the email for the hiring manager/supervisor to review.     
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If you were not able to open the file in MS Word, you have 3 options: 
1. Save the file as an HTML file (web page) and send it to the hiring manager/supervisor to 

open in Internet Explorer 
2. Print the applications and deliver them to the hiring manager/supervisor  
3. Copy and paste all the applications into MS Word or similar software application 

 
OPTION 1: SAVE APPLICATIONS AS AN HTML FILE 

 

 
 

• Click File in the upper left corner and select “Save As” from the drop down menu 
 

 
 

• In the Save Web Page box that appears, type in a file name next to the “File Name” field. 
• In the “Save as Type” field, select Web Page, complete (*.htm; *.html) from the drop down 

menu 
• Click on the Save button 
• Next, open your email and create a new message to the hiring manager/supervisor.  Attach 

the file you just created to the email for the hiring manager/supervisor to review.    
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OPTION 2: PRINT THE DOWNLOADED APPLICATIONS 
 
 

 
 
 

• Click File in the upper left corner and select “Print” from the drop down menu  
• Select the printer you want to print to and click Print 
 

o If you print a paper copy of the application(s) to give to the hiring 
manager/supervisor, the application(s) will include answers to all statewide 
questions as well as any supplemental questions  

 If any of those questions are confidential, the hiring manager/supervisor 
will not see the applicant’s responses 

o Each application will begin on a new page 
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OPTION 3:  COPY AND PASTE DOWNLOADED APPLICATIONS INTO MS WORD 
 

 
 
• Click on the “Edit” tab in the upper left corner 
• Click Select All 
 

 
 
• Click on the “Edit” tab again with all the fields highlighted in the downloaded file 
• Select “Copy” 
• Open MS Word  
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• Click on the “Edit” tab in the upper left corner 
• Select “Paste” and the downloaded applications will be added to a new document 
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• Click on the “File” tab in the upper left corner 
• Select “Save As”  
• Type a file name next to the “File Name” field.  You may want to include the Req #, the Job 

Title, and/or the Hiring Manager’s in the file name. 
• In the “Save as Type” field, select Word Document from the drop down menu 
• Click on the Save button. 
• Next, open your email and create a new message to the hiring manager/supervisor.  Attach 

the file you just created to the email for the hiring manager/supervisor to review.     
 

o If you copy and paste a large number (20 or more) of downloaded applications 
into MS Word, you may have problems if your computer does not have enough 
memory to store the copied applications in memory before it can paste it into MS 
Word.  Each application will vary in length, depending on the number of 
statewide questions and supplemental questions.  Some applications will be 5 or 
more pages when pasted into MS Word.   

o Consider this option only if the other 2 options do not work. 
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Print Applications from Insight-HR(Basic Step by Step) 

 
 
• Log in to 69.225.112.10 
• Click on “Log In” in the upper right hand corner of screen 
• Type in Username and Password 
• Select the “Insight-Human Resources” radio button 
• Click “Log-In” 
• Under “Candidate Track” at the top of the screen, select “Active” 
• Locate your job posting title 
• Click “Print” under the Applications column 
• Fill in “Start Date” and “End Date” (These are the dates when the applications were 

received.  Allows you to pull only applications that you need) 
• Select “Download Type” 
• Select “Source” 
• Select “Processing Type” 
• Click on “Download Now” 
• Follow instructions from above to print applications 

 
 
 
 
 
 
Print and Download Submitted Applications from HR(Detailed) 
  
1.   Access MyHR 
2.   From the ‘CandidateTrack’ pull-down menu, select ‘CandidateTrack’ 
3.   The CandidateTrack search screen displays 
4.   Locate the recruitment you wish to print 

·         To Search by Job Number: 
o        Select the ‘Job Number’ radio button 
o        Enter the Job Number in the grey text box 
o        Click on the upper ‘Search Button’ 

·         To Search by Job Title: 
o        Select the ‘Job Title’ radio button 
o        Enter the Job Title in the grey text box 
o        Click on the upper ‘Search Button’ 

·         To Search by Recruiter Name: 
o        Select the recruiter name from the ‘Search by Recruiter’ drop down box 
o        Click on the upper ‘Search Button’ 
** Note:  You may further refine your search by choosing both a recruiter name and a 
specific Job Number or Job Title 

·         To Search by Applicant SSN/Name: 
o        Enter the applicant’s SSN in the ‘SSN’ textbox 
o        Enter the applicant’s first name and/or last name in the ‘First Name’, ‘Last Name’ 

text boxes 
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o        Click on the lower ‘Search Button’ 
·         To Search by Application Submitted Date Range: 

o        Enter the ‘from’ date in the ‘Date 1’ text box 
o        Enter the ‘to’ date in the ‘Date 2’ text box 
o        Click on the lower ‘Search Button’ 
** NOTE:  You may further refine your search by entering both an applicant name as 
well as entering a date range 
  

 
  

5.   Click on the corresponding ‘Print’ link for the recruitment 
  

 
  
6.   Enter in the appropriate download information: 

• Date Range – Date range applications were submitted 
• Download Type –  

o Download Applications Only – Download applications, non-confidential 
agency-wide supplemental questions, and job-specific supplemental questions 

o Download Applications And Resumes – Download applications, non-
confidential agency-wide supplemental questions, job-specific supplemental 
questions, and resume information 

o Download Confidential Report – Download applicant demographic information, 
confidential agency-wide supplemental questions, and job-specific supplemental 
questions 

• Source –  
o Both – Download applications received online and on paper 
o Online – Download applications received online only 
o Paper – Download applications received on paper only 

• Processing Type – 
o Browser Real-Time – downloads applications in a PDF file immediately.  This 

option is recommended for printing less than 25 applications at a time, and when 
the document headers/footers are not necessary.  The selected applications display 
in a browser pop-up window, and can be printed directly from the web browser.   



 15      

o PDF Batch – downloads applications in a PDF file while you do other work and 
sends an Email notification when the batch process is complete.  This option is 
recommended if you are printing more than 25 applications at a time.  The 
selected applications will be converted to a PDF document which is accessible 
through the ‘Batch’ link on the ‘Candidate Track’ page.  When this option is 
selected, the user receives an email notification when the PDF file is ready.  The 
PDF file can then be saved to your computer and printed. 

  
  

 
  
7.   Click on the ‘Download Now’ button 
8.   The applications received within the defined date range will display 
9.   To navigate through the applications: 

• Click on the applicant’s name you wish to view 
• Click on the ‘Next’ or ‘Previous’ links to navigate by one application 
  

 
  

10.   To print the applications, download the applications into an Adobe Acrobat (.PDF) file: 
• To download all applications listed 

o        Click on the ‘Download All Applications’ link 
• To download a subset of applications 

o        Select the checkbox to the left of the applicant names 
o        Click on the ‘Download Selected Applications’ button 

11.   For Browser Real-Time processing: 
• Selected applications will be rendered to a pop-up browser window in a printer-friendly 

format.  If you do not see a new browser window, try minimizing all other open 
windows.  Also make sure that you do not have any pop-up blocker software enabled. 

• To print the applications form the browser printer window, click File | Print from the 
menu. 

12.   For PDF Batch processing: 



 16      

·           A message is displayed indicating that you will be notified when the PDF file has been 
created.  The message includes a ‘Return to CandidateTrack’ link that returns you to the 
‘Open Recruitments’ page of the CandidateTrack menu: 

  

 
  

·           An email notification is sent once the batch process is completed.  When you return to 
the ‘Open Recruitments’ page, the ‘Batch’ link will be highlighted: 

  

 
  

·           Click on the ‘Batch’ link to display the Batch Report: 
  

 
  

·           To view the .PDF applications online 
o        Click on the ‘View’ link 

• To save the .PDF applications to disk 
o        Click on the ‘Save’ link 
o        A pop-up message will display 
o        Click the ‘Save’ button 
o        Select the folder to save the file into 
o        Click on the ‘Save’ button 

13.   To print the .PDF applications, click on the  icon 
  
Congratulations!  You have successfully printed Submitted Applications. 
  
  
 
 
 
 


